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Introduction 
 

Mova eGrants Overview  
The Mova eGrants Portal specializes in improving functionality and ease of use.  These are the areas that the Mova 
eGrants Portal shines in: 
 

• Mova eGrants Dashboard – The Mova eGrants Dashboard allows users to drill down through new reporting panels 
for funding account information, program budgets, and even view staff performance information.  

 

• SAM.GOV System Interface – The new system interface automatically gathers address and contact information 
during registration and confirms a valid DUNS number.  It also allows the system to check for expiration dates and 
confirm whether an organization can receive federal funding. 

 

• Easy Configuration of Program Changes – The Mova eGrants portal takes advantage of a new drag-and-drop 
configuration engine to allow users to make changes to their programs.  This includes easily updating forms, process 
flows, and management reports.  

 

• Updated Accessibility Features – Mova eGrants was built from the ground up to adhere to ADA and WCAG 2.1 AA 
standards.  The portal will also undergo regular 3rd party web accessibility compliance audits.  It includes new 
options like a high contrast mode and new branding utilities, making it easier to accommodate individuals with 
disabilities. 

 

Current Mova eGrants Contact Information 
Mova eGrants has supplied the following contact information for users:  
 

Agency/Individual Name Phone Number Email Address Website URL 

Agate Software Helpdesk 1 (800) 820-1890 helpdesk@agatesoftware.com  
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System Requirements 
 
The system was designed so that computer users can use it with little or no changes to their computer environment. The 
requirements that are mentioned below are common computer elements that should be already present. 
 

Internet Connection 
The grants management system is an internet application designed for and accessed via the internet.  
 

Internet Access 
This system was designed to be compatible with common up-to-date web browsers such as Microsoft Edge, Chrome, 
Firefox, or Safari.  If the web browser is not up to date, the following message will display: 
 

 
 

Enabling Cookies 
The web browser must enable cookies for this site in order to access this portal. 
 

Multiple Browser Windows 
Do not open multiple windows or browser tabs while filling out the document, as this can cause issues with browser 
cookies resulting in either being kicked out of the system or work being lost. 
NOTE: If the user needs to have multiple windows open please insure that the user is using a separate browser 
session instead.  
 
If utilizing Microsoft Edge, click on File → New Session for each browser session. Other internet browsers will require 
third party add-ons to manage multiple browser sessions. 
 

Adobe Acrobat DC 
Adobe Acrobat DC (Adobe Acrobat Reader) is used to view PDF (Portable Document Format) documents. The system will 
automatically generate grant documents in PDF format using information that has been saved into the various narrative 
and budget pages. Using Adobe Acrobat DC, the user may choose to view, print, or save these documents.  Users who 
do not have this software installed on their systems will need to download it from www.adobe.com. 

  

http://www.adobe.com/
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System Login Page 
 

URL 
To access the Mova eGrants portal, type the following into the address bar of the web browser and press Enter.  
https://mova.intelligrants.com/ 
 
NOTE: The Mova eGrants portal does not save the username and password. This option may be available for some 
browsers. 
 

MOVA eGrants Portal Home Login Page Sections 
 

 
Figure 1 The Login Page 

 
The Mova eGrants portal login page is organized into Public Reports, Welcome/Announcements, and Login sections. 
 

Public Reporting Tab (Still in the development stages) 
 

Accessing the Public Reporting Tab 
Clicking on this tab will bring up a list of reports available to both registered and unregistered Mova eGrants portal 
users. 
 

 
 

https://mova.intelligrants.com/
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Running Reports 
A user can enter specific search criteria and click the Search button to run a report. 
 

 
 

Welcome/Announcements 
This is the section where are welcomed to the portal and allowed to view posted announcements.  These 
announcements may include links. 
 

MOVA eGrants Portal Login Section 
The MOVA eGrants portal login process requires a user to enter in a User Name and Password to login. 
NOTE: The password field is case sensitive and will not recognize characters of the wrong case. Precision when 
entering the username into the username field will decrease the risk of error messages being generated by the 
system. 
 

Logging in to the MOVA eGrants Portal 

User Name 
The user name is created by the new user during the registration process OR by the user adding this user to the 
organization. 
 

Password 
The password is created automatically by the portal once a new user is added. 
 

Submit Button 
Push the Submit Button to login onto the MOVA eGrants Portal. 
 

Trouble Shooting Issues Logging in to the MOVA eGrants Portal 

Forgot Username 
The MOVA eGrants portal allows the user to request the retrieval of their username. To do so, complete the following 
steps: 

1) Click on the Forgot Username/Password! link. 
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2) Click on the Forgot Username link.  
 

 
 

1) Enter the email address and click on the Email button. An email will be sent to that email address with the user’s 
username. 
 

2) The user can follow the instructions in the “Forgot Password” section to allow them to log into the system. 
 

“Locked Out” 
Once a user has exceeded 3 login attempts for the portal, they are “locked out”. The user may use the Forgot Password 
link to request a temporary password at any point.  Instructions for using the “Forgot Password” link are provided 
below. 
 

Forgot Password 
The MOVA eGrants portal allows the user to request a temporary password be generated and sent to their email 
address. To do so, complete the following steps: 

1) Click on the Forgot Username/Password! link. 
2) Enter the username and the email address. Click on the Email button. A temporary password will be sent to the 

email address supplied. 
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3) Once the user has received a temporary password, they will need to login.  

NOTE: The password field is case sensitive and will not recognize characters of the wrong case. Precision when 
entering the username into the username field will decrease the risk of error messages being generated by 
the system. 
WARNING: IF YOU COPY AND PASTE YOUR NEW PASSWORD FROM THE EMAIL TO THE LOGIN PASSWORD BOX 
BE SURE NOT TO COPY AN EXTRA SPACE. THIS WILL LEAD TO UNSUCCESSFUL LOGIN ATTEMPTS AND LOCKOUT 
FROM THE SYSTEM. 
 

4) At that point, the user will be brought directly to the Profile page and requested to create a new password. The 
user can use the Edit Password button at the bottom of the page to update the password.  When the user clicks 
on the Edit Password button, the Password and Confirm Password fields are available. 

 

 
 

New User 
The MOVA eGrants portal allows the user to request access to the system. To do so, complete the following steps: 

1) Click on the New User? Click Here link. 
 

 
 

2) Fill in the required fields (*) and any optional fields desired and click on the Save button. 
NOTE: Users registering by the New User link will need to be approved by pre-existing MOVA eGrants portal 
users. 
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NOTE: If a user attempts to access the system before they have been approved, the system will show their 
password as invalid. 

 
 
Legend 
First Name (Required) – the first name of the registering user. 
Middle Name – the middle name of the registering user. 
Last Name (Required) – the last name of the registering user. 
DUNS (Required) – the DUNS number for the organization the user is registering with.  Enter in the DUNS number and 
click Search to locate the DUNS number for that organization. 
 
Organization (Required) – the name of the organization the registering user wants to register under. 
Title – the position title of the registering user. 
Street Address (Required) – the street address of the organization the user is registering for. 
State (Required) – the state drop-down selection for the state of the registering user’s organization. 
County (Required) – the county drop-down selection for the county of the registering user’s organization. 
City (Required) – the name of the city of the registering user’s organization. 
Zip Code (Required) – the zip of the registering user’s organization. 
Email (Required) – the email address of the registering user. 
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Phone (Required) – the phone number of the registering user. 
Username (Required) – the username the registering user wishes to register for.   
Password/Verify Password (Required) – the password the registering user wishes to register for. 

User Information 
 
Once a person logs into the system, their Profile page and a list of organizations the individual belongs to is visible. 
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Profile 

 
 

 
Basic Information Legend 
First Name – the first name of the individual. 
Middle Name – the middle name of the individual. 
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Last Name – the last name of the individual. 
Prefix – an optional prefix for the individual. 
Suffix – an optional suffix for the individual. 
Title – the position title for the individual. 
Primary Phone – the primary phone number for the individual. 
Secondary Phone – the optional secondary phone number for the individual. 
Email – the email address of the individual. 
 
Address Information Legend 
Street Address – the street address for the individual. 
City – the city the individual’s street address is in. 
State – the dropdown menu of the state the individual’s street address is in. 
Zip – the zip code the individual’s street address is in. 
County – the dropdown menu of the county the individual’s street address is in. 
 
Additional Information Legend 
Job Certification – a repository for uploading personal certification forms. 
 
Security Image – an optional security image to implement as an additional security measure. 
 
Username – a label containing the username of the individual and a button that allows the individual to update the 
username. 
 
Password – a label containing the current password of the individual and a button that allows the individual to update 
the password. 
 

Organization Roles and How to Add a User 
This section contains a table with the label for the role the individual has in that organization, the active date field, the 
inactive date field, and the name of the person who assigned that individual to the organization.  
NOTE: A person can have multiple organizations listed. 
 
New System Roles 
Agency Administrator – Manages Entity Users and their roles; manages information about the organization; manages 
assignments of users associated with different Applications and Awards 

• Access to forms: ALL forms available on eGrants 
 
Application Submitter – Submits complete Applications on behalf of an organization 

• Access to forms: All functions of application process 
 
Programmatic Contact – Manages and submits programmatic requirements of Awards, including submission of 
performance reports, on behalf of an agency 

• Access to forms: Performance Reports; Programmatic Change Forms; Consultant Request Forms; Travel 
Authorization Forms, Site Visit Forms 

 
Alternate Programmatic Contact – Manages and submits programmatic requirements of Awards, including submission of 
performance reports, on behalf of an agency (Alternate if the Programmatic Contact is unavailable) 
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• Access to forms: Performance Reports; Programmatic Change Forms; Consultant Request Forms; Travel 
Authorization Forms; Site Visit Forms  

 
Fiscal Contact – Certifies and submits financial information and all federal financial reports on behalf of an Entity 

• Access to forms: Expenditure Reports; Budgets, Fiscal Site Visit Forms 
 
Authorized Representative – Enters into an agreement on behalf of the Entity and binds it to the Award terms and 
conditions 

• Access to forms: ALL forms 
 
View Only – Can view all forms within organizations profile 
 
 
Below is a table that shows which roles can be assigned by the subrecipient. For example, an Authorized Representative 
can only assign Agency Administrators. 
 

Subrecipient Role Allowed to Assign 
Authorized Representative Agency Administrators 

Fiscal Contact Fiscal Contact 

Agency Administrator Agency Administrators, 
Alternate Programmatic Contacts, 

Application Submitters, 
Authorized Representatives, 

Fiscal Contacts, 
Programmatic Contacts, 

View Only 

Programmatic Contact Programmatic Contact, Alternate 
Programmatic Contacts 

Alternate Programmatic Contacts Alternate Programmatic Contacts 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Adding Users to Organizations 
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To add a user to an organization: 
 

1) Select the logged in user’s name in the top right corner. 
2) Click Profile. 

 
 
3) Select Organization Members under Organization Information, in the left-hand navigation panel. 

NOTE: If the user has multiple organizations, they will be listed in this navigation panel. 
 

 
 

This will take the user to the Organization Members page. Here they can search for existing members in an organization, 
view all members within the organization, and add additional members to the organization. 
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4) In the Members Search panel, click the green plus in the right corner. 

 
 

5) Selecting the green plus will bring up the Add Person modal. This is where the grantee will fill out the 
information regarding the new member they are adding. The grantee will need to complete all required fields, 
assign a role, and create a username and password for the new role. 

 
6) After all required fields have been complete, select the green save button in the bottom right to create the new 

user. 
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Home 
 
The Home page is the home page for Mova eGrants portal users. From here, the rest of the system can be navigated.  
 

 
 

Tabs 
Home 
This is a navigation link that will return the user to the Home page from anywhere in the system. 
 

Searches 
This is a navigation link that will allow the user to conduct document searches for that organization.  The user can access 
this link from anywhere in the system.  
 

Menu Options 
• Applications 

• Progress Reports (In development stages) 
 

Reports (Still in development stages) 
This is a navigation link that will allow the user to access documents available to that organization.  The user can access 
this link from anywhere in the system.  
 

Menu Options 
Report Group 
 

Icons 
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Theme 
Setting 

This button switches the theme visible from black and white to color and vice versa. 

   

   

 

UI Editor Clicking this button allows the user to modify Dashboard elements 

   

   

 
Help Clicking this button allows general help tips to display about the current item selected. 

   

   

Name 
Clicking on the user’s name allows the user to access the Profile, Messages, Edit 
Dashboard, and Logout links. 

   
   

 

Dashboard 
My Tasks 
The My Tasks area is an area that defines the tasks assigned to the user.  It also gives the user a way to initiate a related 
document (like a report or requisition).  This area can be filtered using the Filter function. 
 

 
 

Using the My Tasks Filter 
To use the My Tasks Filter to on a list of tasks assigned to the user, please follow these instructions: 

1. Click on the > sign next to the Filter header. 
2. Enter data into any of the fields and/or select an option from the Type drop-down. 
3. Click the Search button. 

 

 
 

Announcements 
The Announcements area is an area that allows the user access to announcements from the portal designers.  These 
announcements can include (but are not limited to) training dates, news updates, or web site links. 
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My Opportunities 
The My Opportunities area allows the user to start grant opportunity documents (usually applications). 
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Grant Opportunities 
Starting a Grant Opportunity 
To start a grant opportunity, please follow these instructions: 

1) Click on the grant opportunity name in the Name column.  This brings up a menu with more information and the 
Agree or Decline buttons. 
 

 
 

2) Click on the Agree button. 
 

Working on a Grant Opportunity 
Start the grant opportunity using the instructions in the previous section.   

NOTE: The default page for the application is the Document Landing Page. 
 

The Document Landing Page 
The Document Landing Page contains several sections and the New Note button in the upper right corner.   
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Application Link 
The number listed above the Forms header is the application number.  It also functions as a link to bring the user back to 
the Document Landing Page. 
 

Forms Menu 
The Forms Menu is divided into sections containing individual forms for the user(s) to fill in.  There are drop-down 
arrows next to the Forms header that allow the forms to be hidden and other sections uncovered.   
 

 
 

Legend 
Forms – the list of forms.  Usually forms without sections are listed first, then the form list is broken in to sections. 
Tools – a list of tools available to the user. 
Status Options – a list of possible status options to apply to the application. This list will vary from user to user, 
depending on which role the user is logged in as and current status of the application. 
 
Related Documents – a list of related documents (primarily reports) associated with the application. 
 

Document Details 
The Document Details section provides visual data including the grant opportunity status, future statuses, the name of 
the organization, the role of the user currently logged in, and both the Period Date and Due Date. 
 

New Note Button 
The New Note button allows a user to leave a note for other users. 
 

Grant Opportunity Forms 
Forms 
The list of forms is usually divided into sections, with the first section visible being the default form location.  
 



MOVA eGrants - Subrecipient Manual Version 4  
 

2/10/21 Copyright © Agate Software, Inc.  
Page 22 of 
43 

   
 

 
 
Clicking on a form link in any section will bring up that form for the user to fill in. 
 

 



MOVA eGrants - Subrecipient Manual Version 4  
 

2/10/21 Copyright © Agate Software, Inc.  
Page 23 of 
43 

   
 

 

Form Options 
There are additional tools in the purple banner on the right side of the screen. 
 

 
 
Legend 
New Note – allows the user to create a new note for other users.  
NOTE: For more information, please see the Notes section in the Tools area. 

 
Save – allows the user to save the form. 
Add – allows the user to create an additional instance of the form.   It is the digital equivalent to being handed an extra 
piece of paper of a specific form to staple to an existing packet of forms. 

 
Delete – allows the user to delete the instance of the form that is visible to the user.  Clicking on the Delete button will 
clear out the fields on the form (including any uploaded attachments). 
 

Tools 
The Tools section contains a list of customized tools available to the user depending on the role assigned to the user.   
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Legend Summary 
Landing Page – the default application page. 
Add/Edit People – allows the user to add/edit people associated with a specific document. 
Attachment Repository – allows the user to access a list of stored attachments. 
Modification Summary – allows the user to access a summary of modifications for a specific document. 
Status History – allows the user to access a history of the status(s) of a specific document. 
Notes – allows the user to create/view/edit notes for a specific document. 
Print Document – allows the user to create a PDF of the document. 
 

Landing Page  
Clicking on this link returns the user to the Document Landing Page. 
 

Document Add/Edit People 
This tool allows authorized users to add/edit people assigned to the document. 
 

 
 
Adding/Assigning People to the Document 
To add/assign a person to the specific document, please follow these instructions: 

1) Click on the Plus Sign button on the People Assigned to this Document panel. 
2) Select the Person and Role options from the drop-down menus. 
3) Click the Save button.  

NOTE: This will automatically assign today’s date.  If a past active date is required, please use the menu in the 
Active Date field to select the date. 
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Editing People Assigned to the Document 
To edit the role of a user assigned to the specific document, please follow these instructions: 

1) Click on the Pen button on the right side. 
2) Select a role from the Role drop-down list. 

Optional: Update the Active Date field. 
 

3) Click the Save button. 
 

 
 

Attachment Repository 
This tool allows the user to view files that have been added as attachments throughout the document. 
 

Document Modification Summary 
This tool allows the user to view and/or download the modification summary. 
 

Status History 
This tool allows the user to view the status of the document – including the Status name, Date/Time the document had 
that status, and the name of the Person who changed the status of that document.  There is also a field for status notes. 
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Notes 
This tool allows the user to add/edit notes. 
 

 
 
Adding a New Note 
Please use these instructions to create a note. 
 

1) Click on the New Note button. 
2) Fill in the field. 
3) Click on the Paperclip icon to add a note (optional). 
4) Click on the Paper Airplane icon to SAVE the note. 

 

Additional Fields 
Icon Name Description 

 

 
 

Internal Note This tool locks this note into the form as an internal note.  The internal notes are only 
visible to members within the same organization. 

 

 
 

Attachment(s) This tool allows the user to add attachments to the note. 

 

 
 

Editor This tool allows the user to edit a note. 

 

 
 

Save Note This tool allows the user to save the note. 

 
Locating a Note 
Once a note is created, it ends up in the Notes area of the Tools menu.   
To access the note, please follow these instructions: 
 

1) Click in the Forms section to minimize that section. 
2) Click on the Notes link in the Tools section. 
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Updating a Note 
1) Click in the Forms section to minimize that section. 
2) Click on the Notes link in the Tools section. 
3) Click on the … icon.  This brings up the Edit, Delete and External/Internal tool buttons. 

 

 
 

4) Click on the Edit tool to edit the text field. 
 

 
 

5) Click in the text field to adjust the formatting and/or the contents of the note. 
6) Click the paper airplane icon to save the updates to the note. 

 
Deleting a Note 

1) Click in the Forms section to minimize that section. 
2) Click on the Notes link in the Tools section. 
3) Click on the … icon.  This brings up the Edit, Delete and External/Internal tool buttons. 
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4) Click on the Delete button to delete the note. 
 
Replying to a Note 

1) Click in the Forms section to minimize that section. 
2) Click on the Notes link in the Tools section. 
3) Add a response to the Reply section and click on the airplane icon. 

 

 
 

Print Document 
This tool allows the user to create a PDF version of the document to save onto the user’s computer and/or print out. 
Each form has the option of being included in the printout (with both questions and answers), excluded in the printout, 
or including a blank version of that form. 
 

 
 

Status Options 
The Status Change area allows the user to change the status of a document.  This is normally useful for submitting 
applications, signing contracts, or requesting grant modifications. 
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Related Documents 
The Related Documents section is where the user can access documents (such as reports) that are related to the 
application/contract. 
 

Accessing a Report (Still in the development stages) 
To access a report, please follow these instructions: 

1) Navigate to the grant. 
2) Close the Forms, Tools, and Status Options sections. 
3) Click on the report link in the Related Documents section. 
4) Click on the report link in the 2nd column.  This will bring up the Document Landing Page for the report. 

 

 
 

Starting a Report 
Click on the Initiate Related Doc button (either in the Related Documents section or in the My Tasks area of the 
Dashboard). 
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Searches 
 
The Searches tab is used to quickly locate specific documents.  Different types of searches have their own search 
sections set up.  The sections below explain how to use these search sections. 
 

 
 
Legend 
Name – A text field for the name of the document. 
Organization – A text field for the name of the organization that created the document. 
Type – A drop-down list to select the type of document from. 
Status – A drop-down list to select a specific document status from. 
Sub Code – A text field to enter the sub code of the document in. 
 

Application/Grant 
To use this search tab, please follow these instructions: 

1) Go to Searches → Applications. 
2) OPTIONAL: Enter in search parameters.  Click the Clear button to clear out search parameters. 
3) Click the Search button. 
4) Click on the name of a specific document in the Name column. 

 

 
 
Legend 
Name – A text field for the name of the document. 
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Organization – A text field for the name of the organization that created the document. 
Type – A drop-down list to select the type of document from. 
Status – A drop-down list to select a specific document status from. 
Sub Code – A text field to enter the sub code of the document in. 
 

Progress Reports (still in the development stages) 
To use this search tab, please follow these instructions: 

1) Go to Searches → Progress Reports. 
2) OPTIONAL: Enter in search parameters.  Click the Clear button to clear out search parameters. 
3) Click the Search button. 
4) Click on the name of a specific document in the Name column. 
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Reports (Still in the development stages) 
 
This tab is used to access reports that were created using the Report Builder tool.  The reports and report groups that 
visible are entirely dependent on what reports and report groups are created. 
 

Accessing a Report 
To access a report, please follow these instructions: 

1) Go to Reports →[Specific Report Group (Optional)] or [Specific Report]. 
2) Enter in search criteria (optional) and click the Search button. 
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Types of Forms 
 
There are several types of forms within the MOVA eGrants system. These forms can be found within the left-hand 
navigation pane of the Opportunity that the user is applying for. 
 

Information Forms 
Section I Form: This form will require the user to fill out necessary information marked with red asterisks. Upon saving 
the page, users will be flagged with an error message if required fields are not complete. Forms that require completion 
will show an empty checkbox in the left-hand navigation panel. The user can also save a form at any time and come back 
to it later. Forms that have been saved and still require information will show a pencil icon in the left-hand navigation 
panel. 
 

   
               
 
 

Budget Forms 
Salary Form: Subrecipients will have the option to enter direct costs or administrative costs to their application. The 
subrecipient will be asked to enter information in relation to their request for funding. Each direct row and 
administrative row will have the ability to add more line items with the green + sign. Pressing the + sign will add a row to 
the section. Once a second row is added, a – sign will be become available for deleting unwanted rows. Clicking the – 
sign will erase a row from the screen. The first field (Employee Name) will populate into the Budget Narrative section. 
The subrecipient will then be asked to fill out the form with more data.  
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Hyperlink Forms 
Contractor Authorized Signatory Listing Hyperlink: When this type of form is selected, it will prompt a file download for 
the user to fill out and save. 
 
To prompt a file download, please follow these instructions: 

1) Click the Hyperlink Form on the left-hand navigation panel. 
2) This will prompt a file download to appear at the bottom of the screen. 
3) Click on the file’s upload arrow to open the document.  

NOTE: Clicking this upload arrow does not automatically save the file. 
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Upload Forms 
Required Uploads Form: This form will require the user to upload specific documents.  
 
To upload a document, please follow these instructions: 

1) Click the purple “Select” button on the form to open the File Explorer popup window. 
2) Locate the desired file. 
3) Click “Open”. 

 
Once the file has been successfully uploaded, the user should see the file name displayed underneath the upload field. 
To delete an unwanted file, click the ‘X’ found at the end of the uploaded document. 
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Types of Processes 
 
There are several types of processes within the MOVA eGrants system. When a user applies for an Opportunity, there is 
a process that it will follow through to completion.   
 

Expenditure Report Process 
This process is initiated by an Agency Administrator, Authorized Representative, or Fiscal Contact. Log in as one of these 
roles and find a contract that is in the Contract Executed status to initiate an Expenditure Report.  
NOTE: If you were part of the contract before it started, you’ll be able to find this document in your “My Tasks” 
section of the Home screen. 
 

1) Under the MOVA eGrants logo in the top left corner, click on Searches 
2) Select Applications 
3) In the Status dropdown, find Contract Executed and select it.  
4) Click the green Search button. This should populate all the applications in the Contract Executed status. 
5) If you are finding your contract this way you have not yet been added to the document. Please see the add/edit 

portion of this manual to add yourself to this document or have your Agency Administrator or Authorized 
Official help you. 
NOTE: Depending on the program the user is looking for (ex: DDTF, VOCA, SAFEPLAN, VOCA Training), they 
may need to select the specific program in the Type dropdown 

 
 
 
VOCA with Match, VOCA without Match, SAFEPLAN, DDTF Programs 
Forms that need to be filled out: Backup Worksheet, Expenditure Summary 
Backup Worksheet 
The Backup Worksheet is a form where the user will enter in the funds spent. Once a user enters data into the initial 
Backup Worksheets, data will be copy forward on all subsequent Expenditure Reports that are initiated after it. You can 
alter data however when an Expenditure Report is initiated, it will pull the data from the last Expenditure Report and 
populate the Backup Worksheet from the last Backup Worksheet created. 
 
Expenditure Summary 
The Expenditure Summary form keeps track of the funds entered on the Backup Worksheet. It is a summary of current 
and past expenditures for the contract. 
 
 VOCA Training Program  
Forms that need to be filled out: Expenditure Report – Training Grant, Hosting or Expenditure Report – Training Grant, 
Professional Development 
This form keeps track of Year-To-Date expenditures. The user will enter in their expenses on this form. 
 
Finding & Completing Expenditure Forms 
Once an Expenditure Report is initiated, the user will have access to the required forms. On the left-hand navigation 
panel, locate the section titled Forms. This is where the Expenditure Report forms are located. The user can select which 
forms they would like to view or work on. Both the VOCA Expenditure Back-up Worksheet with Match and VOCA 
Expenditure Summary are links that when clicked on will enter you into the form. Enter and save your data in the Back-
up Worksheet, then view the summary to see present and past Expenditure Report data. 



MOVA eGrants - Subrecipient Manual Version 4  
 

2/10/21 Copyright © Agate Software, Inc.  
Page 37 of 
43 

   
 

 
 
 
 
 
 
 
 
Submitting Expenditures  
After a user has initiated an Expenditure Report, filled it out to their satisfaction and is ready for MOVA to review, they 
will have to submit their report. To move to the next step of the process the user will need to select Expenditure Report 
Submitted and confirm the status change. On the left-hand navigation panel under the heading Status Options, there 
will be the option to submit: (Close to the bottom of the menu) 
 

 
Clicking on “Expenditure Report Submitted” will bring up a window and allow to enter comments about this submission 
if they would like or just click OK to confirm they are ready to hand these document over to MOVA for their review and 
approval. 
 
Expenditure Modifications 
Once an Expenditure Report is submitted, and during MOVA review they may require more information from your 
agency on this Expenditure Report. If that happens, MOVA will push the status of this report to Expenditure Report 
Modifications Required. This will send out a notification / email to your users letting you know that more information is 
required by MOVA. Once you are in your Expenditure Report, review the Notes section of the document to see what 
MOVA may require from you. After completing the edits, re-submit this document to MOVA for an additional review.  
 
Expenditure Notifications 
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Certain users will receive notifications upon different status changes. The system notification and email will be sent out 
once the Expenditure reaches its trigger status. For example, when an Expenditure is created it is considered “In 
Process”. When the user has confirmed submission, the Expenditure moves into the status “Expenditure Report 
Submitted”. A notification will be sent once the user pushes to this status. 
 
Expenditure Report in Process TO Expenditure Report Submitted 

• Sent To: Authorized Representative, Agency Administrator, Programmatic Contact, Alternate Programmatic 
Contact  
 

Expenditure Report in GM Review TO Expenditure Report Modifications Required 

• Sent To: Authorized Representative, Agency Administrator, Programmatic Contact, Alternate Programmatic 
Contact 

 
Expenditure Report Ready for Approval TO Expenditure Report Processed 

• Sent To: Authorized Representative, Agency Administrator, Programmatic Contact, Alternate Programmatic 
Contact 

 
 
 
 
 

Performance Report Process 
This process is initiated by an Agency Administrator, Authorized Representative, Programmatic Contact, or the Alternate 
Programmatic Contact. Log in as one of these roles and find a contract that is in the Contract Executed status to initiate 
a Performance Report.  
NOTE: If you were part of the contract before it started, you’ll be able to find this document in your “My Tasks” 
section of the Home screen. 
 

1) Under the MOVA eGrants logo in the top left corner, click on Searches 
2) Select Applications 
3) In the Status dropdown, find Contract Executed and select it.  
4) Click the green Search button. This should populate all the applications in the Contract Executed status. 

NOTE: Depending on the program the user is looking for (ex: DDTF, VOCA, SAFEPLAN, VOCA Training), they 
may need to select the specific program in the Type dropdown 

 
 
VOCA Programs 
Forms that need to be filled out: VOCA Population Demographics, VOCA Types of Victimizations, VOCA Direct Services, 
VOCA Quarterly Reported Questions 
Clicking on the name of the form will take you to the form for edit. 
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SAFEPLAN Program 
Forms that need to be filled out: SAFEPLAN Population Demographics, Types of Abuse, Services Provided 
Clicking on the name of the form will take you to the form for edit. 

 
 
 
DDTF Program 
Forms that need to be filled out: Preliminary PET Performance Report 
Clicking on the name of the form will take you to the form for edit. 

 
VOCA Training Program 
Forms that need to be filled out: Victim Services Training Grant Award Report, Hosting or Professional Development 
(depending on the VOCA Training Contract ) 
Clicking on the name of the form will take you to the form for edit. 
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Finding & Completing Performance Report Forms 
Once a Performance Report is initiated, the user will have access to the required forms. On the left-hand navigation 
panel, locate the section titled Forms. This is where the Performance Report forms are located. The user can select 
which forms they would like to view and or edit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Submitting Performance Reports  
When a user has initiated a Performance Report, fills out the forms without error and is satisfied with the content they 
can submit their report for MOVA review. To move to the next step of the process the user will need to select 
Performance Report Submitted and confirm the status change by clicking OK. On the left-hand navigation panel under 
the heading Status Options, there will be the option to submit: (Click on “Performance Report Submitted” then confirm 
the status change by clicking OK) 

 
Performance Report Modifications 
Once a Performance Report is submitted, and during MOVA review they may require more information from your 
agency on this Performance Report. If that happens, MOVA will push the status of this report to Performance Report 
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Modifications Required. This will send out a notification / email to your users letting you know that more information is 
required by MOVA. Once you are in your Performance Report, review the Notes section of the document to see what 
MOVA may require from you. After completing the edits, re-submit this document to MOVA for an additional review.  
 
Performance Report Notifications 
Certain users will receive notifications upon different status changes. The system notification and email will be sent out 
once the Performance Report reaches its trigger status. For example, when a Performance Report is created it is 
considered “In Process”. When the user has confirmed submission, the report moves into the status “Performance 
Report Submitted”. A notification will be sent once the user pushes to this status. 
 
Performance Report in Process TO Performance Report Submitted 

• Sent To: Authorized Representative, Agency Administrator, Fiscal Contact 
 

Performance Report in Senior Grant Manager Review TO Performance Report Modifications Required 

• Sent To: Authorized Representative, Agency Administrator, Fiscal Contact 
 
Performance Report Modifications Required TO Performance Report Modifications Submitted 

• Sent To: Authorized Representative, Agency Administrator, Fiscal Contact 
 
Performance Report in Review TO Performance Report Approved 

• Sent To: Authorized Representative, Agency Administrator, Fiscal Contact 
 
 
 
 
 
 
 
 
 

Travel Request Process 
This process is initiated by an Agency Administrator, Authorized Representative, Programmatic Contact, or the Alternate 
Programmatic Contact. Log in as one of these roles and find a contract that is in the Contract Executed status to initiate 
the travel request process.  
NOTE: If you were part of the contract before it started, you’ll be able to find this document in your “My Tasks” 
section of the Home screen. 
 

1) Under the MOVA eGrants logo in the top left corner, click on Searches 
2) Select Applications 
3) In the Status dropdown, find Contract Executed and select it.  
4) Click the green Search button. This should populate all the applications in the Contract Executed status. 

NOTE: Depending on the program the user is looking for (ex: DDTF, VOCA, SAFEPLAN, VOCA Training), they 
may need to select the specific program in the Type dropdown 

 
 
All Programs 
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The Form that needs to be filled out is the same for ALL programs. Once this form has been filled out, saved successfully 
and submitted to MOVA, MOVA will then review and let your organization know via email if any further action is 
required or a decision is made.  
 
Submitting Travel Request  
When a user has initiated the Travel Request process, fills out the form without error and is satisfied with the content 
they can submit their request for MOVA review. To move to the next step of the process the user will need to select 
Travel Request Submitted and confirm the status change by clicking OK. On the left-hand navigation panel under the 
heading Status Options, there will be the option to submit: (Click on “Travel Request Submitted” then confirm the status 
change by clicking OK) 
 

 
 
 
Travel Request Modifications 
Once the Travel Request is submitted, and during MOVA review they may require more information from your agency 
on this Travel Request. If that happens, MOVA will push the status of this report to Travel Request Modifications 
Required. This will send out a notification / email to your users letting you know that more information is required by 
MOVA. Once you are in your Travel Request, review the Notes section of the document to see what MOVA may require 
from you. After completing the edits, re-submit this document to MOVA for an additional review.  
 
 
 
 
Travel Request Notifications 
Certain users will receive notifications upon different status changes. The system notification and email will be sent out 
once the Performance Report reaches its trigger status. For example, when a Performance Report is created it is 
considered “In Process”. When the user has confirmed submission, the report moves into the status “Performance 
Report Submitted”. A notification will be sent once the user pushes to this status. 
 
Travel Request in Process TO Travel Request Submitted 

• Sent To: Authorized Representative, Agency Administrator, Programmatic Contact, Alternate Programmatic 
Contact 
 

Travel Request in Review TO Travel Request Modifications Required 

• Sent To: Authorized Representative, Agency Administrator, Programmatic Contact, Alternate Programmatic 
Contact 

 
Travel Request in Review TO Travel Request Denied 
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• Sent To: Authorized Representative, Agency Administrator, Programmatic Contact, Alternate Programmatic 
Contact 

 
Travel Request in Review TO Travel Request Approved 

• Sent To: Authorized Representative, Agency Administrator, Programmatic Contact, Alternate Programmatic 
Contact 

 
 
 

Compliance Monitoring Process 
This process is initiated by the Massachusetts Office of Victim Assistance. This process can be initiated for pre-site forms 
to be filled out in the status of Pre-Site Visit or initiated past this part of the process in which these pre-site forms would 
not be required. You will receive a notification via email and in the MOVA eGrants system itself when this process is 
initiated by MOVA for your organization.  
NOTE: If you were part of the contract before it started, you’ll be able to find this document in your “My Tasks” 
section of the Home screen. 
 

1) Under the MOVA eGrants logo in the top left corner, click on Searches 
2) Select Compliance Monitoring 
3) Click the green Search button. This should populate the compliance monitoring report for your organization. 

 
All Programs 
The Form that needs to be filled out is the same for ALL programs. Once this form has been filled out, saved successfully 
and submitted to MOVA, MOVA will then review and let your organization know via email if any further action is 
required or a decision is made.  
 
Submitting a Compliance Monitoring Report  
When a user has a Compliance Monitoring Report initiated for their organization, fill out the forms without error and 
once you are satisfied with the content, submit the report for MOVA review. To move to the next step of the process the 
user will need to select Pre-Site Visit Submitted and confirm the status change by clicking OK. On the left-hand 
navigation panel under the heading Status Options, there will be the option to submit: (Click on “Pre-Site Visit 
Submitted” then confirm the status change by clicking OK) 


